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Chapter 1

Getting Started

This chapter provides instructions for starting and exiting Qbit-
DB™ and describes the different areas and the functions performed 
at the main window.

Starting/Exiting Qbit-DB

Do one of the following to start Qbit-DB:

• Click [Start], select Programs, click CubiScan, then click Qbit-
DB.

• Double-click the Qbit-DB desktop icon. 

The main window is displayed (see next page).

Do one of the following to exit Qbit-DB:

• Pull down the File menu, and click Exit.

• Click the Close button ([X]) located in the upper right corner of 
the main window.
Quantronix CubiScan Qbit-DB 1



Main Window Getting Started
Main Window

When Qbit-DB starts, the main window is displayed and either an 
empty database table with the default name “Cubiscan” or the last 
database table that was opened is loaded.

All recorded measurement data is saved in the open database table. 
You can open a different database if necessary. Refer to Chapter 3, 
“Database Management” for information.
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Getting Started Main Window
The following functions are performed at the main window:

• Measure and weigh freight (see Chapter 5 “Measuring Freight” 
on page 87).

• Add/update database entries (see “Database View” on page 7).

• Access all other Qbit-DB functions using the menus (see “Menu 
Bar” on page 10).

The main window is divided into several sections, as described in 
the following sections. You can move, resize, or hide some sections 
to make it easier to view only what your needs require (refer to 
“Customizing the Main Window” on page 8).

Stacked Quantities Box

The Stacked Quantities box can be used if you want to stack like 
items for measurement but want the dimensions for each item 
included separately in the database. Refer to Chapter 5, “Measuring 
Freight” for information.
Quantronix CubiScan Qbit-DB 3



Main Window Getting Started
Measurement Section

The Measurement section contains all of the fields and buttons you 
use to measure the height, width, and length of freight, record the 
weight, and enter other appropriate data.

Entry Fields The fields in which you can make an entry include the primary or 
“Item Number” field (can only be edited before the measurement is 
taken), the secondary field if it is enabled, the “Description” field if 
it is enabled, any user fields that have been enabled, and the freight’s 
measurement and weight entries. Some fields are enabled or dis-
abled using the Options on the Tools menu (refer to Chapter 2, 
“Configuration”).

The item number may be selected from an imported database table, 
entered by scanning a label, or entered manually as you measure the 
freight. You can select an item in the database table to edit its mea-
surement fields. You can edit any field that is not grayed. Click in a 
field to edit it, and type over the existing entry. Then click [Update] 
(or press <F4>) to update the information in the database.
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Getting Started Main Window
Repeat Item
Number

If you have enabled the secondary field (see “Secondary Field” on 
page 22), this button is enabled. You can use it to make an additional 
database entry with the same item number (or other primary field 
descriptor) so that you can add another item with the same number 
and a secondary descriptor to make it a unique item.

User Fields The “user fields” section contains user-defined fields. These are 
fields that can be set up to meet your specific requirements. When 
enabled, these fields are available for entry and can be edited in the 
main window. Refer to “User Fields” on page 54 for information.

CubiScan Fields The dimensions and weight of the freight are entered as each item is 
measured with the CubiScan. You can also enter or edit the entries 
in the “Length,” “Width,” “Height,” and “Weight” fields (if “Cubi-
Scan Fields Read Only” is not selected in the View menu).

Database Fields These fields display the information of previously measured items 
or item information that was imported into the database. You can 
compare the imported item information to the item information in 
the CubiScan fields to make sure the measurements have been 
updated in the database.

Measurement
Buttons

The measurement buttons include the buttons you will use to mea-
sure freight with the CubiScan, as follows.

Click the “Measure” button to measure the item on the CubiScan.

Click the “Update” button to update the current item record. You 
must update a record (or “clear” it) before you can measure a new 
item.

Click the “Clear” button to clear the data fields for the current 
record and start over.

Click the “Delete” button to delete the current record. (This button 
must be enabled; refer to “Database Options” on page 23.)
Quantronix CubiScan Qbit-DB 5



Main Window Getting Started
CubiScan Picture Box

After you specify the CubiScan model to which your computer is 
connected (refer to “CubiScan Model” on page 19), a simulation of 
the CubiScan is displayed in the Picture box. After you measure 
freight, the freight and its measurements are also shown.

Information Box

The information box lists any CubiScan activity and gives the status 
of the activity. This includes any configuration changes, measure-
ments taken, and error messages.
6 Quantronix CubiScan Qbit-DB



Getting Started Main Window
Database View

The Database View lists the items in the open database. The col-
umns and number of items visible may depend on how you have 
moved and resized the sections in the main window (see “Customiz-
ing the Main Window” on page 8). You can also resize and rear-
range the columns in the database view (see “Customizing the Data-
base View” on page 8).

Moving Through
the Database

View

Use the horizontal scroll bar to move left and right through the col-
umns and the vertical scroll bar to move down or up through the 
items in the database.

Use the arrow buttons to move up and down through the items, as 
follows.

Click to move to the first item in the database.

Click to move up one item at a time.

Click to move down one item at a time.

Click to move to the last item in the database.

Selecting an Item
Quantronix CubiScan Qbit-DB 7



Main Window Getting Started
Customizing the
Database View

You can change the position and size of the columns in the database 
view, and you can sort the items by any column as follows:

• To change the position of a column in the table, click on the 
heading and drag it to a new position.

• To change the width of a column, move the mouse pointer over 
the side of the column heading until the pointer changes to direc-
tional arrows. Click and hold the mouse button, and drag the side 
of the column until it is the size you want, then release the mouse 
button.

• To sort by the entries in a column, click the column heading. 
Click once to sort in descending order; click again to sort in 
ascending order.

• To return the Database View to its default set up, pull down the 
Database menu, and click Default Column Order.

Refer to Chapter 3, “Database Management” for information on 
managing databases.

Customizing the Main Window

You can move, resize, or hide some sections of the main window to 
customize the display.

• The Stacked Quantities box, CubiScan picture, Message box, 
Database View, and Measurement section can be resized.

• The Stacked Quantities box, CubiScan picture, and Message box 
can be separated from the main window and moved to a different 
position.

• The Stacked Quantities box, CubiScan picture, Message box, 
and Database fields can be hidden or shown.
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Getting Started Main Window
Resizing To resize a section, move the mouse pointer over any side or corner 
until the pointer changes to directional arrows. Click and hold the 
mouse button, and drag the side or corner of the section until it is the 
size you want, then release the mouse button.

NOTE ☞ You can resize the entire main window using the same method.

Moving Each section that can be separated has a “docking bar” at the top 
when the section is docked, or in a fixed position, in the window.

To move the section, click the docking bar, hold down the mouse 
button, and drag the section to another location in the window. As 
you drag it, you will see an outline that indicates the position and 
size it will be. When it is in the position you want, release the mouse 
button. If you move a section to a floating, or undocked, position, 
the docking bar changes to a title bar. To move a floating section, 
click the title bar, hold down the mouse button, and drag the section. 
When you move it into a docked position, the docking bar appears 
again.

NOTE ☞ If you do not want the section to “snap” into a docked position, hold 
down the <Ctrl> key as you drag it. It then becomes a floating sec-
tion that can be positioned anywhere on the screen.

Docked positions are on either side of the measurement section. If 
all sections are open, they can be positioned one on top of the other 
on either side, side by side on either side, or on each side of the win-
dow.
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Menu Bar Getting Started
Hiding/Showing To hide the Stacked Quantities box, CubiScan picture, Message box, 
or the Database fields (in the Measurement section), pull down the 
View menu, and click the section you want to hide. Pull down the 
menu and click it again to show a hidden section.

You can also click the [x] on the docking bar or title bar of the 
Stacked Quantities box, CubiScan picture, or Message box. To show 
the section again, select it from the View menu.

Saving a View After you have customized the view of the main window, you can 
lock the sections into place, save the new arrangement as the default 
view, or return to the default view. Pull down the View menu, and 
select a function, as follows:

• Load Default View
Select this function to return the main window to the default 
view.

• Save as Default View
Select this function to save the new arrangement as the default 
view.

• Lock View
Select this function to “lock” the position of the sections so they 
cannot be moved. Select Unlock View to “unlock” the sections.

Menu Bar

The menus at the top of the main window contain functions used to 
perform tasks and set up Qbit-DB. Click a menu name and the menu 
drops down from the menu bar. Click a function on the menu to 
select it. If a function has an arrow on the right, a submenu is dis-
played when you click the function.

You can also select a function by typing the first letter in the func-
tion name.
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Getting Started Menu Bar
File Menu

Following are the functions available on the File menu.

Import Use this function to manually import data from an external source 
file. Refer to “Importing a Database” on page 63.

Export Use this function to export all or a portion of the Qbit-DB database 
to an FTP site, an ASCII text file, or a Microsoft Excel file. Refer to 
“Exporting a Database” on page 66.

Exit Use this function to exit Qbit-DB.

Database Menu

Following are the functions available on the Database menu.

New Table Select this function to create a new database table. Refer to “Creat-
ing a New Database” on page 58.

Open Table Select this function to open an existing database table. Refer to 
“Opening a Database” on page 59.

Delete Table Select this function to delete a database table. Refer to “Deleting a 
Database” on page 60.

Empty Table Select this function to empty or clear the currently open database 
table. Refer to “Emptying a Database” on page 61.

Save Copy As Use this function to make a backup copy of the MSAccess .mdb 
database. Refer to “Copying a Database” on page 62.

Default Column
Order

Select this function to arrange the database columns in their default 
order.
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View Menu

Picture Click this function to show or hide the CubiScan Picture. A check-
mark indicates it is shown.

Stacking Click this function to show or hide the Stacked Quantities box. A 
checkmark indicates it is shown.

Message Box Click this function to show or hide the Message Box. A checkmark 
indicates it is shown.

CubiScan Fields
Read Only

Click this function to make the CubiScan fields read only. With this 
function selected, you will not be able to make entries or edit infor-
mation in any of the CubiScan fields.

Database Fields Click this function to show or hide the Database Fields. A check-
mark indicates they are shown.

Load Default View If you have changed the arrangement of sections of the main win-
dow (see “Customizing the Main Window” on page 8), select this 
function to return it to the default view.

Save as Default
View

If you have changed the arrangement of sections of the main win-
dow (see “Customizing the Main Window” on page 8), select this 
function to save the new arrangement as the default view.

Lock View If you have changed the arrangement of sections of the main win-
dow (see “Customizing the Main Window” on page 8), select this 
function to “lock” the position of the sections so that cannot be 
moved. Select Unlock View to unlock them.

Tools Menu

Following are the functions available on the Tools menu. The 
“Zero,” “Status,” “Test Mode,” “Values,” and “Calibrate” functions 
may not be available (grayed) depending on whether or not the 
functions are available on the selected CubiScan model.
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Getting Started Menu Bar
Zero Use this function to “zero” the CubiScan. Refer to “Zero” on 
page 76.

Status Use this function to verify that the CubiScan is operating properly. 
Refer to “Status” on page 77.

Test Mode Use this function to set up the CubiScan for testing purposes. Refer 
to “Test Mode” on page 79.

Values Use this function to display a table of sensor values that can be use-
ful for troubleshooting problems with the CubiScan. Refer to “Val-
ues” on page 80.

Calibrate Use this function to calibrate the scale and sensors. Refer to “Cali-
brate” on page 80.

Options Use this function to configure Qbit-DB. Configuration options 
include setting the serial port, selecting your CubiScan model, 
determining the measurement units, setting up import and export 
options, setting up user-defined fields, setting up a password, and so 
on. Refer to Chapter 2 “Configuration” on page 17 for details.

Caliper Menu

This menu is only displayed if a CubiScan 30 model is selected in 
the Tools menu, Options, CubiScan tab. The following functions are 
available. Refer to the CubiScan 30 Operations and Technical Man-
ual for instructions.

Length When using the CubiScan 30 caliper to manually measure an object, 
select this function to measure the length.

Width When using the CubiScan 30 caliper to manually measure an object, 
select this function to measure the width.

Height When using the CubiScan 30 caliper to manually measure an object, 
select this function to measure the height.
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Actions Menu

Following are the functions available on the Actions menu.

Swap Length for
Width

Select this function to switch the length and width measurement val-
ues for the current item.

Swap Width for
Height

Select this function to switch the width and height measurement val-
ues for the current item.

Swap Height for
Length

Select this function to switch the height and length measurement 
values for the current item.

Reports Menu

Following are the functions available on the Reports menu.

Detail Select this function to generate a report that lists all information in 
the currently loaded database table. The report can be viewed on 
screen or printed. Refer to Chapter 6 “Reports” on page 95.

Help Menu

Following are the functions available on the Help menu.

About Select this function to display the current version and build of Qbit-
DB and information about Quantronix, Inc.
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Status Bar

The Status Bar is located at the bottom of the main window and pro-
vides the following information.

Name of the currently loaded database table.

Currently selected record number and the total number of records.

Whether or not the records have been updated. Until a record is 
updated, the label reads: “Updated Records = 0.” After one or more 
records are updated, it reads: “Updated Records = xx” (where xx is 
the total number of updated records in the current database).

Move the mouse over a menu or function, and a description of the 
menu or function is displayed.

If you scheduled an automatic import (see “Auto Import” on 
page 37), the number of hours/minutes/seconds to the next import is 
displayed. If you have not set up auto import, “Next Import: Dis-
abled” is shown.
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If you scheduled an automatic export (see “Auto Export” on 
page 44), the number of hours/minutes/seconds to the next export is 
displayed. If you have not set up auto export, “Next Export: Dis-
abled” is shown.
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Chapter 2

Configuration

This chapter provides information and instructions to configure and 
set up defaults for Qbit-DB using the Tools, Options function. The 
following tabs contain the configuration options:

• CubiScan
Set up the measurement and dimensional weight units, select the 
CubiScan communications port, select your CubiScan model, 
and enter a site ID (optional).

• Database
Set up database fields, options, and tare values. This tab also 
contains the option to convert an older Qbit-DB database to the 
new format.

• Password
Set up password security for selected functions.

• Import
Select import options, set up the layout of the imported database 
fields, and set up the automatic import function.

• Export
Select export options, set up the layout of the exported database 
fields, and set up the automatic export function.

• Factors
Enter the values used for dimensional weight factors.

• Fields 1-4, Fields 5-8
Set up from one to eight user-defined fields.
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CubiScan Configuration
Select Options from the Tools menu to open the Options dialog 
box. Refer to the following sections for information on the options 
in each tab. Click [OK] to save changes you made to any tab and exit 
the dialog box. Click [Cancel] to exit without saving.

CubiScan

Click the CubiScan tab to set up the measurement and dimensional 
weight units, select the CubiScan communications port, select your 
CubiScan model, and enter a site ID (optional).
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Unit of Measure Options

Dimension Units Select the measurement units you want used to measure length, 
width, and height dimensions: Inches, Millimeters, or Centime-
ters.

Weight Units Select the units you want used for package weights: Ounces, 
Pounds, Grams, or Kilograms.

Volume Units Select the units you want used to measure volume: Cubic Inches, 
Cubic Feet, Cubic Millimeters, Cubic Centimeters, or Cubic 
Meters.

Dimensional Weight
Units

Select whether you want to use Domestic or International dimen-
sional weight units. Refer to “Factors” on page 52 for information 
on setting up dimensional weight factors.

CubiScan Options

Communication
Ports

Enter the number of the CubiScan serial port to which the computer 
communications cable is connected.

CubiScan Model

Select the model of CubiScan you are using. Options in some tabs 
may vary depending on the CubiScan model selected. In addition, 
the CubiScan measuring display and the menus and functions avail-
able in the main window will change to match the selected model.

NOTE ☞ It is important to select your CubiScan model and click [OK] to save 
it before continuing to set up configuration options.

If you select the CubiScan 30 with serial numbers starting with 9 or 
20 to 24, you are prompted to enter the CubiScan serial number.
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Enter the serial number and click [OK] to close the prompt and con-
tinue.

Site ID

If measurement data from your site will be exported and merged 
with measurement data from other sites, you may want to assign a 
“Site ID” number to each site to identify the site that supplied the 
data. If used, the site ID number is shown in the “Site ID” column in 
the database table.

Enter an identification code for your site using any alphabetic or 
numeric characters but no symbols or spaces.

Database

Click the Database tab to set up database fields, options, and tare 
values. This tab also contains the option to convert an older Qbit 
database to the new format.
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Primary Field

The “primary field” is the first field in the editable fields section of 
the main window with “Item Number” as the default label.

The primary field receives an item’s identification number, whether 
typed, scanned, or selected from an imported data file. The follow-
ing options allow you to customize this field:

Field Name By default, the primary field label is “Item Number.” Type a new 
name in the text box to change the label. The new label replaces 
“Item Number” in the main window and in the database view.
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Field Length Enter the maximum number of characters that can be entered in the 
key field (from 1 to 35). You will not be allowed to enter more than 
the specified number of characters in the field.

Key Field Option This option can be used to limit the type of characters that can be 
entered in the primary field to help prevent data input errors. Select 
the option for the type of characters to be allowed in the key 
field: Any Character, Alpha Numeric Characters, Alphabetic 
Characters, or Numeric Characters. If you do not want to define 
any restrictions, select Any Character.

Secondary Field

In addition to the primary field, you can enable a secondary field 
that can be used to enter an additional descriptor under the primary 
field label. For example, you can enter a product number in the pri-
mary field and then enter a pack type in the secondary field.

Enable Secondary
Field

Select this option to enable the secondary field. The field becomes 
available for entry under the primary field in the main window, and 
the [Repeat Item Number] button is enabled.

You use the [Repeat Item Number] button to make an additional 
database entry with the same item number (or other primary field 
descriptor) so that you can add another item with the same number 
and a secondary descriptor to make it a unique item.

Allow Manual Entry
in Addition to Pick

List

After you enable the secondary field, you can enter a pick list of 
items or descriptions from which to choose at the secondary field. 
Select this option if you want to be able to make a manual entry in 
the secondary field in addition to selecting from the pick list.

Secondary Field
Pick List

Click in the text box and enter a list of items from which to choose 
at the secondary field. Press <Enter> after each item. The items 
entered become available for selection from a drop-down list in the 
secondary field.
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Database Options

The database options determine how items are entered in the data-
base and whether or not you can delete item records.

Add/Update Items Select this option if you add items to the database more often than 
you update existing items. This makes adding items the default, and 
a warning message appears when you update an existing item.

Item records are identified by the descriptors in the primary field 
(generally item number) and the secondary field if it is enabled. You 
cannot add an identical item to a database, but you can change and 
update an item.

If the secondary field is not enabled, an identical item is any item 
with the same item number. If the secondary field is enabled, an 
identical item is any item with the same item number and the same 
secondary field entry.

If you attempt to add an identical item, the following warning mes-
sage is displayed.

Select [Yes] to overwrite the existing item or [No] if you did not 
intend to change the existing item.

Verify Item Exists
Before Update

Select this option if you update existing items or import data in a 
database more often than you add new items. This option is used 
with its sub-options to give you multiple variations, as follows.
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Allow New Items to be Added (enabled)
If this option is enabled, updating existing items is the default, but 
items can also be added to the database.

Allow New Items to be Added (disabled)
If this option is not enabled, you can only update existing items; you 
cannot add new items. If you attempt to add a new item, the 
following warning is displayed.

Auto Advance through Items
Select this option if you generally measure items in the order they 
are listed in the existing database. If enabled, after you select the 
first item, Qbit-DB automatically moves down the list in sequential 
order as each item is measured and updated. However, you can also 
manually click an item to select it if necessary.

Enable Record
Delete Button

Select this option if you want to be able to delete an item record 
from the database. The [Delete] button in the main window 
becomes available; otherwise, it is grayed.

Tare Values

Tare values are preset dimensions to be subtracted from a measure-
ment. If a tare value is included and the resulting measurement or 
weight is less than zero, the reading will be zero.

Tare values are not used in most applications but may be used in 
some circumstances.
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Enable Tare Option If you use tare values all or part of the time, click this option to 
enable tare. If enabled, you must apply the tare values after measur-
ing an item.

Length
Width

Height
Weight

Enter tare values for measurements and weight as applicable. Each 
specified value is subtracted from the dimension measurement or 
weight. 

To apply tare values to a measurement, select Apply Tare Values 
from the Actions menu (or press <Ctrl><T>) after measuring the 
item.

Description Field

Enable Description
Field

Select this option to enable the “Description” field in the main win-
dow (under the primary and secondary fields). You can then enter a 
description for each item, which will appear in the database table.

Include this field
when repeating

Select this option if you want the item description included when 
you repeat an item number. (Repeat is only available if the second-
ary field is enabled; refer to “Secondary Field” on page 22.)

Hide Field Select this option if you do not want the “Description” field dis-
played in the main window.

Convert Qbit-Win/Qbit-WMS Database

Because older versions of Qbit created Paradox databases, and Qbit-
DB creates Access databases, a database from an older version of 
Qbit cannot be loaded into the current version. Take the following 
steps to convert a Paradox database to an Access database.

1. Since the new database will be loaded into Qbit-DB when the 
conversion takes place, you must start with an empty database. 
From the Database menu, select either New Table and enter a 
name for the converted database table, or select Empty Table to 
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erase all records from the currently loaded database table and 
replace it with the converted database table.

2. Click [Convert Qbit-Win/Qbit-WMS Database] to convert a 
database from a previous version of Qbit to the current version. 
The following dialog box is displayed.

3. Select the Qbit application in which the database you want to 
convert was created.

4. Click [Find Old Table] to find the old Qbit database. The fol-
lowing dialog box is displayed.
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5. If it is not already selected, browse to the ...\CubiScan\Qbit\ 
Data folder containing the old database that you want to con-
vert. All files with a .db extension are listed. Select the database 
file to convert and click [Open].

The Paradox database table is displayed in the “Old” box with 
the number of records in the database shown.
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6. Click [Convert]. The database is converted, and the following 
prompt appears.

7. Click [OK] to close the prompt.

The new Access database table is displayed in the “New” box, 
and the record count is shown.

8. Click [Close] to exit the dialog box.

The new database table is opened in Qbit-DB. Refer to Chapter 3, 
“Database Management” for information on databases.
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Password

To provide security for specified functions in Qbit-DB, you can set 
up a password. Once a password is set up, the selected functions are 
dimmed in the menus and only become available when the password 
is entered. The “Options” function is always included when pass-
word protection is enabled for any function.

Password Options Select the functions for which a password will be required.
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Set Password Click this button to set up or change the password. The following 
dialog box is displayed.

In the “Enter Password” box, type the password. In the “Re-enter 
Password” box, type it again for verification. The password is case 
sensitive; if you enter upper or lower case characters, they must be 
entered in the same case when entering the password. Click [OK] to 
accept the password.

Clear Password Click [Clear Password] to remove an existing password. This 
allows access to all functions by all users. The message: “Password 
has been cleared” is displayed. This means that a password is no 
longer required to use any functions in Qbit-DB. Click [OK].

When you attempt to access a function that has been password pro-
tected, the following prompt appears.

Enter the password exactly as it was entered when set up (case sen-
sitive), and click [OK] to open the function.
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Import

The Import option on the File menu is used to import data from an 
external ASCII text file source. (Refer to “Importing a Database” on 
page 63 for information.) Click the Import tab to set up the import 
options, the layout of the imported database fields, and the auto-
matic import function.

Import Type

Select the Import Type tab to set up the options that define the type 
of files that can be imported.
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Import File Type Select the file type to be used when importing database tables. The 
default is delimited.

Delimited
Variable length, delimited files (.csv or .txt file extension) contain 
variable length records, each separated by a carriage return/line feed 
pair. Fields may vary in length and are separated by field separators. 
Leading and trailing spaces for nu
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Append/Update
New items are added to the existing database, and any duplicate 
items are updated.

Import Delimited
File

This option is only available if you selected “Delimited” as the 
import file type. Select the delimiter type used in the text file: 
Comma, Tab, or Other. If you select “Other,” enter the delimiter in 
the “Import File Delimiter” box. 

Import Layout

The layout of the information in the text file must match the Qbit-
DB database layout to be imported correctly. You must set up the 
Import Type options before you map the layout (see “Import Type” 
on page 31).

Do the following to map the fields in the text file to the Qbit-DB 
database fields. 
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1. Select the Import Layout tab.

2. Create a sample file from the file you want to import. The file 
should contain a sample of every field in the import file so that 
all fields can be mapped to a corresponding field in Qbit-DB. 
The sample file must be the same type that you selected under 
“Import File Type” in the “Import Type” tab.
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3. Click [Load Sample] to load the sample file you created. The 
following dialog box is displayed.

4. If necessary, browse to the folder containing the sample file, 
select the file, and click [Open].

The fields from the sample file are listed under “Sample Fields.” 
Fields are read left to right and are determined by the import file 
type you selected (delimited, fixed length, or Excel) and, if 
delimited, the delimiter you selected. For example, if you speci-
fied a tab-delimited file, each time a tab is encountered, the data 
following it is set up as a new field.
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5. Click each sample field to select it, then click the “table field” 
next to it, and select from the drop-down list the Qbit-DB data-
base field to which you want to map the import file field. See 
the illustration above for examples.

To move backwards and forwards from item to item in the sample 
file, click the arrows beneath the list of fields.

To clear all of the fields and start over, click [Clear All].
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Auto Import

To set up Qbit-DB to automatically import a file at a specified time 
of day or at specified time intervals, click the Auto Import tab.

NOTE ☞ You must set up the Import Type options and map the layout before 
you set up auto import (see “Import Type” on page 31 and “Import 
Layout” on page 33).

After you set up an auto import, the number of hours/minutes/sec-
onds to the next scheduled import is displayed in the status bar of 
the main window (see “Main Window” on page 2).
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Import File Location
and Name

Enter the directory path and file name of the import file you want to 
schedule, or click [Browse] to find the file. The following dialog 
box is displayed.

Browse to the folder containing the import file, select the file name, 
and click [Open]. The path and file name are inserted in the field.

Import Frequency Options

Import Mode Select the mode for automatic importing, as follows.

Off
Select this option to disable automatic import.

Import at Specified Time of Day
Select this option to set up a time of day to import the selected file. 
The “Import Times” options become available to set up the time(s) 
of day for import.

Import at Specified Time Interval
Select this option to set up a time interval to import the selected file. 
The “Import Interval Timer” options become available to set up the 
time interval for import.
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Import Times If you selected “Import at Specified Time of Day,” this section is 
available to set up the time of day you want the file imported.

You can set up four different times to import a file. Click Enable 
Time 1 to enter the first import time. Then type the time of day in 
the “Time 1” text box in a 12-hour clock format (i.e., 1:00 AM, 2:00 
PM, and so on). Do the same to set up times 2 through 4 as required.

The selected file will be imported automatically every day at the 
specified time or times until you disable the time.

Import Interval
Timer

If you selected “Import at Specified Time Interval,” this section is 
available to set up the interval timer.

Click the arrow buttons to scroll up or down from 1 to 23 hours, 1 to 
59 minutes, and 1 to 59 seconds. Click once to scroll one at a time, 
or click and hold to scroll quickly through the numbers in sequence.

The selected file will be imported automatically at the specified 
time intervals. For example, if you select 2 hours, the file will be 
imported every 2 hours.
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Export

The Export option on the File menu is used to export data to an 
external ASCII text file or upload it via FTP (File Transfer Proto-
col). (Refer to “Exporting a Database” on page 66 for information.) 
Click the Export tab to set up the export options, the layout of the 
exported database fields, and the automatic export function.

NOTE ☞ The options in the Export tab do not apply when you export a data-
base using the “Run Manual Excel Export” function (see page 70).

Export Type

Select the Export Type tab to set up the options that define the type 
of files that can be exported.
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Export File Type Select the file type to be used when exporting database files. The 
default is delimited.

Delimited
Variable length, delimited files (.csv or .txt file extension) contain 
variable length records, each separated by a carriage return/line feed 
pair. Fields may vary in length and are separated by field separators. 
Leading and trailing spaces for numeric and character fields are 
truncated. The format of date fields depends on your Windows 
regional settings. If you select this option, additional options to 
define the delimiter type become available at the bottom of the tab 
(see “Import Delimited File” on page 33).

Fixed Length
Fixed length files (.txt file extension) contain fixed length records, 
each separated by a carriage return/line feed pair. Fields are fixed in 
length with no field separators. Character fields are padded with 
trailing blanks, and numeric fields are padded with leading blanks. 
The format of date fields depends on your Windows regional 
settings.

Export Header
Information?

Select Yes if you want to include header information in the file 
when it is exported. Select No if you do not want to include it.

Export Delimited
File

This option is only available if you selected “Delimited” as the 
export file type. Select the delimiter type used in the text file: 
Comma, Tab, or Other. If you select “Other,” enter the delimiter in 
the “Export File Delimiter” box. 

Add Double
Quotation Marks

Around Character
Strings

Select this option if you want quotation marks placed around char-
acter strings in the exported file. The double quotation marks will 
keep the characters within the quotation marks together in the 
export file.

NOTE ☞ To export a file that you want to load into Microsoft Excel, choose 
“comma-delimited.”
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Export Layout

You can change the layout of the database table for the export file. 
You can select which fields you want included, change the length of 
the field, change the decimal point location, or even rearrange the 
fields. You must set up the Export Type options before you change 
the layout (see “Export Type” on page 40). Do the following to set 
up the fields in the database table for export.

Select the Export Layout tab.

Click [Load Defaults] if you want to export the database as it 
appears in Qbit-DB, or to display all of the fields in the database 
table so that you can edit the layout.
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Click [Clear All] to clear all of the fields from the layout list.

Click a table field and then click [Remove] to remove the field from 
the exported database.

Click a table field and then click [Insert] to insert a field above the 
selected field.

Click a table field and then click [Move Up] to move the selected 
field up one position in the table.

Click a table field and then click [Move Down] to move the selected 
field down one position in the table.

Click the drop-down arrow at a table field to display a list of avail-
able fields and select a field name to add or change a field label.

NOTE ☞ The “SPACE FILLER” option in the drop-down list can be used to 
specify an empty or blank field.

If you specified fixed length as the file type in the “Export Type” 
tab, click in the second column next a field to change the starting 
position (in number of characters) of the field.
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If you specified fixed length as the file type in the “Export Type” 
tab, click in the “Size” column next to a field to change the number 
of characters in the field.

Click in the “Decimals” column for a field to add or change the 
number of characters after the decimal point for entries in the field. 
This applies to decimal fields only (e.g., dimensions, weight, vol-
ume.

Auto Export

To set up Qbit-DB to automatically export a file at a time of day, at 
specified time intervals, or after every update, click the Auto Export 
tab. 

NOTE ☞ You must set up the Export Type options and the Export Layout 
before you set up auto export (see “Export Type” on page 40 and 
“Export Layout” on page 42). 

After you set up an auto export, the number of hours/minutes/sec-
onds to the next scheduled export is displayed in the status bar of the 
main window (see “Main Window” on page 2).

Click the Frequency tab to set up the time(s) to export the file, then 
click the Destination tab to select the type of output.
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NOTE ☞ The options in the Destination tab are not available until you select 
a frequency option in the Frequency tab.

Frequency Click the Frequency tab to set up the mode and times to export.

Export Mode Select the mode for automatic exporting, as follows.

Off
Select this option to disable automatic export.

Export at Specified Time of Day
Select this option to set up a time of day to export the database file. 
The “Export Times” options become available to set up the time(s) 
of day for export.
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Export at Specified Time Interval
Select this option to set up a time interval to export the database file. 
The “Export Interval Timer” options become available to set up the 
time interval for export.

Export After Each Update
Select this option to automatically export the current database file 
each time it is updated. No other options are necessary in this tab if 
you select this option.

Export Times If you selected “Export at Specified Time of Day,” this section is 
available to set up the time of day you want the file exported.

You can set up four different times to export a file. Click Enable 
Time 1 to enter the first export time. Then type the time of day in 
the “Time 1” text box in a 12-hour clock format (i.e., 1:00 AM, 2:00 
PM, and so on). Do the same to set up times 2 through 4 as required.

The database file will be exported automatically every day at the 
specified time or times until you disable the time.
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Export Interval
Timer

If you selected “Export at Specified Time Interval,” this section is 
available to set up the interval timer.

Click the arrow buttons to scroll up or down from 1 to 23 hours, 1 to 
59 minutes, and 1 to 59 seconds. Click once to scroll one at a time, 
or click and hold to scroll quickly through the numbers in sequence.

The database file will be exported automatically at the specified 
time intervals. For example, if you select 2 hours, the file will be 
exported every 2 hours.

All Data
Updated Data

If you selected a time of day or time interval for the export, select 
whether you want to export All Data in the database or only the 
Updated Data.
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Export Configuration
Destination Click the Destination tab to set up the type of output for the export 
file.

Select whether you want to upload the export file to a host using 
FTP or output the file to an ASCII text file. You can select one or the 
other or both options.

Activate FTP Upload

Select Activate FTP Upload to activate the FTP upload option. The 
data is saved in a text (.txt) file in the .../CubiScan/Qbit-DB/FT 
folder. The file name indicates the date and time the file was cre-
ated.
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Configuration Export
Set up the options to upload the database file to a host via FTP when 
it is exported automatically. You can obtain this information from 
your network administrator.

FTP Enter the login information required by your network for file 
transfer.

User ID
Enter a valid user ID (required for upload access to the host site).

Password
Enter a valid password (required for upload access to the host site).

Remote Host
Enter the name of the FTP host (e.g., ftp.host.com)

Remote Port
Enter the port used for the transfer, normally “21.”

Remote Path
Enter the directory path on the host. Be sure to use the correct 
syntax for the server type (e.g., \...\ or /.../).

Remote File Name
Enter a name for the file on the host.

Upload Mode Select the option you want to use to create the exported file.

Overwrite Existing File
Select this option to overwrite a previously uploaded file.
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Export Configuration
Append Data to File
Select this option to append (add) the uploaded file to an existing 
file.

Create Unique Files
Select this option to export the data into a unique file that will 
contain only the exported records.

Transfer Mode Select the file transfer method.

ASCII
Select this option if you want the file to be exported in ASCII (plain 
text) mode.

Binary
Select this option if the file contains formatted text, non-text 
characters, or other data not interpreted as text.

Network Mode Select your network mode.

Passive
Select this option if your network uses passive FTP.

Active
Select this option if your network uses active FTP.

Trace Mode Select whether you want packet tracing on or off for the file transfer.

FTP Transfer
Process

After you have configured the frequency and FTP settings, the file 
transfer process is automatic and only requires periodic monitoring 
of the message box to identify any problems (messages in red). 
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Configuration Export
Activate ASCII Text File Output

Select this option to output the exported data to an ASCII text file.

File Location and
Name

Enter a directory path and complete file name for the exported file. 
Or click [Browse], and the following dialog box is displayed.

Browse to the folder in which you want to save the file. If you want 
to write over or append to an existing file, select the file name; if 
you want to create a unique file, enter a file name in the “File name” 
field (including the extension, which can be any ASCII text file 
extension, e.g., .txt, .csv). Click [Save]. The path and file name are 
inserted in the field in the “Auto Export” tab.
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Factors Configuration
Output Mode Select the option you want to use to create the exported file.

Overwrite Existing File
Select this option to overwrite a previously uploaded file.

Append Data to File
Select this option to append (add) the uploaded file to an existing 
file.

Create Unique Files
Select this option to export the data into a unique file that will 
contain only the exported records. The file format is the month, day, 
year, hour, minutes, and seconds the file was created with a hyphen 
and the file name you entered (e.g., 051209170159-unique.xls).

Factors

Click the Factors tab to enter or edit the domestic and international 
dimensional weight factors for the CubiScan. A dimensional weight 
is calculated for each measurement (both domestic and interna-
tional).
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Configuration Factors
An item’s dimensional weight is its density based on volume and is 
calculated using the following equation:

Dimensional Weight = Length * Width * Height / Factor

Defaults Click [Defaults] to use the default values provided by Quantronix. 
Or, click in each text box and enter your own values for each factor.
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User Fields Configuration
User Fields

User fields are fields in which you can enter in the database any 
additional information you want about an item. User fields are 
labeled “User Field 1” through “User Field 8” by default, however 
you can change the labels. Two tabs are available to set up user 
fields: Fields 1-4 and Fields 5-8.

Use the following options to set up one or more user fields. 

NOTE ☞ User Field 8 is numeric only.
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Configuration User Fields
Field Name Type a label for the field. The label is displayed in the place of the 
“User Field” default label in the main window and as the column 
heading in the database table.

Field Length Enter the maximum number of characters that can be entered in the 
field (from 1 to 30). You will not be allowed to enter more than the 
specified number of characters in the field.

Enable Field Select this option to enable the user field. Once enabled, the field 
becomes available after the item number is entered and remains 
available until the record is updated.

Mandatory Entry Select this option if you want an entry to the field to be mandatory. 
A valid entry will be required in the field before the item record can 
be updated.

Include This Field
When Repeating

Select this option if you want the user field included when you 
repeat an item number. (Repeat is only available if the secondary 
field is enabled; refer to “Secondary Field” on page 22.)

Hide Field Select this option to hide a disabled user field in the main window.

Data Entry Type This option can be used to limit the type of characters that can be 
entered in the field to help prevent data input errors. Click the option 
for the type of characters to be allowed: Any Character, Alpha 
Numeric Characters, Alphabetic Characters, Numeric Charac-
ters, or Y/N Character (yes/no). If you do not want to define any 
restrictions, select Any Character.
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Notes
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Chapter 3

Database Management

Item measurements and weights are stored in item records (by item 
number) in a Qbit-DB database table (Access database). This chap-
ter provides information and instructions on managing your Qbit-
DB databases. Most of the database functions are found on the 
Database menu. The Import and Export functions are on the File 
menu.

When you start Qbit-DB for the first time, an empty database is 
opened with the default name “Cubiscan.” All of the measurements 
and weights of the freight you measure are recorded and saved in 
the open database. You can do either of the following:

• Record the information in the “Cubiscan” database table.

• Create a new database table using the “New Table” function (see 
“Creating a New Database” on page 58).

If you already have a Qbit-DB database or databases, the last data-
base loaded is opened when you start Qbit-DB. You can do any of 
the following:

• Save new measurements and weights in the open database table.

• Open a different database table using the “Open Table” function 
(see “Opening a Database” on page 59).

• Create a new database table using the “New Table” function (see 
“Creating a New Database” on page 58).
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Creating a New Database

Do the following to create a new database.

1. Pull down the Database menu and select New Table, and the 
following prompt is displayed.

2. Type the name that you want to give the new database table.

NOTE ☞ If you enter the name of an existing database table, an error mes-
sage appears warning you that the database already exists.

3. Click [OK] and the new, empty database table is opened so you 
can begin entering data into it.
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Opening a Database

Do the following to open an existing database.

1. Select Open Table from the Database menu, and the following 
dialog box is displayed.

All of the database tables in Qbit-DB are listed.

2. Click the name of the database table that you want to open, and 
the table is loaded into Qbit-DB.

Click [Cancel] if you do not want to open a new table.
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Deleting a Database

Do the following to delete a database table.

1. Select Delete Table from the Database menu, and the following 
dialog box is displayed.

All of the database tables in Qbit-DB are listed.

2. Click the name of the database table that you want to delete, and 
the following warning is displayed.
60 Quantronix CubiScan Qbit-DB



Database Management Emptying a Database
3. All records in the selected database table will be deleted and 
cannot be recovered. Click [Yes] if you want to delete the speci-
fied database table.

The following message is displayed.

4. Click [OK] to close the message.

Emptying a Database

Do the following to delete all of the records from a database table.

1. Make sure the table from which you want to delete all records is 
the open table.

2. Select Empty Table from the Database menu, and the following 
prompt is displayed.

3. All records in the open database table will be deleted and cannot 
be recovered. Click [Yes] if you want to empty the database 
table.
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Copying a Database Database Management
The following message is displayed.

4. Click [OK] to close the message.

Copying a Database

You can save a copy of a database table to use as a backup in case of 
problems with the database or a hard disk or other computer failure. 
Do the following to save a copy of a database table (the original 
database table remains unchanged).

1. Select Save Copy As from the Database menu, and the follow-
ing dialog box is displayed.
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Database Management Importing a Database
2. Database tables are saved in the ...\CubiScan\Qbit-DB folder by 
default. If you want to save the copy to a different drive or 
folder, select the drive letter and/or folder at the “Save in” box.

3. Type a name for the duplicate database table in the “File name” 
field. The “.mdb” file extension is added automatically.

4. Click [Save] to save the duplicate database. The original data-
base remains available in Qbit-DB. The database that was open 
when you performed the copy function remains open.

You should save backups on removable media (e.g., thumb 
drive, tape, Zip disk, etc.) and store them in a secure place so 
that they are available in the event of a hard disk or other com-
puter failure.

Importing a Database

Use the Import function on the File menu to import data from an 
external ASCII text file source. You must set up the import file 
options before importing a file (refer to “Import Type” on page 31). 
Also, the layout of the information in the text file must match the 
Qbit-DB database layout to be imported correctly. Refer to “Import 
Layout” on page 33 for instructions on mapping the fields in an 
import file to the Qbit-DB database fields.

NOTE ☞ Because older versions of Qbit create Paradox databases while 
Qbit-DB creates Access databases, you cannot import a database 
from a previous version of Qbit. To load a database from a previous 
version of Qbit, use the “Convert Qbit-Win/Qbit-WMS Database” 
function in the Database tab of the Options function. Refer to “Con-
vert Qbit-Win/Qbit-WMS Database” on page 25.

Do the following to import data into a database.
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1. Open the database to which you want to add or update the new 
data (see “Opening a Database” on page 59).

If you want to create a new database with the imported data, 
create a new, empty database with a unique name in which you 
will insert the imported data (see “Creating a New Database” on 
page 58).

2. Pull down the Tools menu, and select Options.

3. Click the Import tab and then the Import Type tab.

4. Select the method you want to use to import the data into the 
existing database.

Append Only
Only new items are added to the existing database. Duplicate 
items (items with the same item numbers) are not added or 
updated).
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Database Management Importing a Database
NOTE ☞ You may want to back up an existing database table before import-
ing the file into it. Refer to “Copying a Database” on page 62 for 
information.

7. Select Import from the File menu. The following dialog box is 
displayed.

8. If necessary, at the “Look in” box, click  or  and select the 
drive/folder containing the file you want to import.

9. If necessary, at the “File of type” box, click  and select the 
format of the imported file.

10. Click the name of the text file to import, and it is inserted in the 
“File name” field.

11. Click [Open] to import the file into the open database table.

The status of the import process and any errors encountered are dis-
played in the message box.
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Exporting a Database

Use the Export option to export an entire Qbit-DB database or a por-
tion of a database to a variable or fixed length format ASCII text file 
that can be loaded into a different application or moved to a differ-
ent computer and imported into Qbit-DB. You can also use “auto 
export” to upload the database via FTP. You must set up the export 
file options before exporting data (see “Export Type” on page 40). 
You can also change the layout of the Qbit-DB database table to be 
exported (not applicable to the “Run Manual Excel Export” func-
tion). Refer to “Export Layout” on page 42 for instructions.

Click Export on the File menu, and a submenu is displayed with the 
following functions:

Run Auto Export
Select this function to start the automatic export that you have 
already set up. (See “Auto Export” on page 44.)

Run Manual Export
When you click this function, a submenu is displayed with the 
following options: 

• All Data
Select this option to create a text file that contains all records in 
the current database.

• Updated Data
Select this option to create a text file that contains only records 
updated or added since the last export.

• Date Range
Select this option to create a text file containing all records 
updated or added within a specified period of time.

Run Manual Excel Export
When you click this function, a submenu is displayed with the 
following options: 
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• All Data
Select this option to create a text file that contains all records in 
the current database.

• Updated Data
Select this option to create a text file that contains only records 
updated or added since the last export.

• Date Range
Select this option to create a text file containing all records 
updated or added within a specified period of time.

Refer to the following sections for information on each function.

Run Auto Export

You can use the “Run Auto Export” function to start the automatic 
export that you have set up. The export will take place immediately 
using the options that you set up in the “Auto Export” tab in Options 
(refer to “Auto Export” on page 44).

This function is useful if you want to manually upload the database 
to a network using FTP. Set up auto export by selecting the “Acti-
vate FTP Upload” option and entering the required login and mode 
information. Then select Run Auto Export to upload the data 
immediately.

Run Manual Export

Select this function if you want to manually export all or part of the 
database to a text file. Select one of the following options.

All Data/
Updated Data

Select the “All Data” option to create an export text file containing 
all records in the current database, or select the “Updated Data” 
option to create an export file containing only records updated or 
added since the last export. An updated record is indicated by a “Y” 
(Yes) in the “Updated” (last) column in the database table. After a 
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record has been exported, an “N” (No) is shown in the “Updated” 
column.

Take the following steps to export data using either the “All Data” or 
“Updated Data” option.

1. Pull down the Tools menu, and select Options.

2. Click the Export tab and then the Export Type tab.

3. Select the export file type and other applicable options (see 
“Export Type” on page 40).

4. If you want to change the layout of the data, click the “Export 
Layout” tab and make the desired changes (see “Export Layout” 
on page 42).

5. Click [OK] to save and close the Options dialog box.

6. Select All Data or Updated Data from the Run Manual Export 
submenu. The following dialog box is displayed.
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7. Export files are saved in the ...\CubiScan\Qbit-DB\Data folder 
by default. If you want to save the file to a different drive and/or 

folder, click  or  at the “Look in” box, and select the 
drive/folder.

8. Enter a name for the export file in the “File name” field, includ-
ing the extension, which can be any ASCII text file extension 
(e.g., .txt, .csv).

If you want to copy over an existing export file, select the 
drive/folder containing the file you want to copy over, and click 
the file name to insert it in the “File name” field.

9. Click [Save] to export the database table to the file.

The status of the export and any errors are displayed in the message 
box.

Date Range Use the “Date Range” option to save an export text file containing 
all records that were updated or added within a specified period of 
time.

1. Select Date Range from the Run Manual Export submenu, and 
the following dialog box is displayed.
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2. By default, the “from” date is yesterday’s date, and the “to” date 

is today’s date. To change a date, click  and a calendar is dis-
played from which to choose the date, as follows.

3. Select the date, and click [OK]. The date is inserted in the “From 
Date” or “To Date” field.

The export file will contain all records added or updated on and 
between the dates you selected.

4. Click [OK] to export the data to the file.

The status of the export and any errors are displayed in the message 
box.

Run Manual Excel Export

Select this function if you want to manually export all or part of the 
database to a file that can be loaded directly into Microsoft Excel. 
You cannot change the layout of the database if you use this export 
option. The items in the export file will be in the same physical 
order as in the database table with header information.

Select one of the following options.
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All Data/
Updated Data

Select the “All Data” option to create an export text file containing 
all records in the current database, or select the “Updated Data” 
option to create an export file containing only records updated or 
added since the last export. An updated record is indicated by a “Y” 
(Yes) in the “Updated” (last) column in the database table. After a 
record has been exported, an “N” (No) is shown in the “Updated” 
column.

Take the following steps to export data using either the “All Data” or 
“Updated Data” option.

1. Pull down the Tools menu, and select Options.

2. Click the Export tab and then the Export Type tab.

3. Select the export file type and other applicable options (see 
“Export Type” on page 40).

4. Click [OK] to save and close the Options dialog box.

5. Select All Data or Updated Data from the Run Manual Excel 
Export submenu. The following dialog box is displayed.
Quantronix CubiScan Qbit-DB 71



Exporting a Database Database Management
6. Export files are saved in the ...\CubiScan\Qbit-DB\Data folder 
by default. If you want to save the file to a different drive and/or 

folder, click  or  at the “Look in” box, and select the 
drive/folder.

7. Enter a name for the export file in the “File name” field. The .xls 
file extension is added automatically.

If you want to copy over an existing export file, select the 
drive/folder containing the file you want to copy over, and click 
the file name to insert it in the “File name” field.

8. Click [Save] to export the database table to the file.

The status of the export and any errors are displayed in the message 
box.

Date Range Use the “Date Range” option to save an export text file containing 
all records that were updated or added within a specified period of 
time.

1. Select Date Range from the Run Manual Excel Export sub-
menu, and the following dialog box is displayed.
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2. By default, the “from” date is yesterday’s date, and the “to” date 

is today’s date. To change a date, click  and a calendar is dis-
played from which to choose the date, as follows.

3. Select the date, and click [OK]. The date is inserted in the “From 
Date” or “To Date” field.

The export file will contain all records added or updated on and 
between the dates you selected.

4. Click [OK] to export the data to the file.

The status of the export and any errors are displayed in the message 
box.
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Notes
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Chapter 4

CubiScan Functions

This chapter provides information on the Qbit-DB functions used to 
verify, reset, and test the CubiScan. These functions are selected 
from the Tools menu and include the following:

• Zero
Use this function to set all empty measurements and weight to 
zero.

• Status
Use this function to verify that the CubiScan is operating prop-
erly.

• Test Mode
Use this function to set up the CubiScan for testing.

• Values
Use this function to display a table of sensor values that can be 
useful for troubleshooting problems.

• Calibrate
Use this function to calibrate the sensors and the scale.

NOTE ☞ The “Zero,” “Status,” “Test Mode,” “Values,” and “Calibrate” 
functions may not be available (if not available, they are dimmed or 
grayed) depending on whether or not the functions are available on 
the selected CubiScan model.

Refer to the following sections for more information on each func-
tion.
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Zero

Use the Zero function to “zero” the CubiScan. Zeroing sets all 
empty measurements and weight to zero. The weight of the platform 
and the measurement from each sensor to the platform sides when 
the platform is empty must be set to zero for the CubiScan to oper-
ate properly. A CubiScan zeros itself automatically every five sec-
onds when it is not in Measure mode. However, you may need to 
manually zero the CubiScan in the following circumstances:

• If, during a long measuring session, environmental conditions 
(temperature and humidity) have changed noticeably.

• If you suspect that the last zeroing was in error (e.g., something 
was on the platform).

NOTE ☞ Make certain that the CubiScan platform is free of all objects before 
using Zero. If not, the zero reading will not be accurate.

1. Pull down the Tools menu, and select Zero. The following 
prompt is displayed.

2. Verify that the CubiScan platform is free of ALL objects, then 
click [OK] to proceed.
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3. After the scale and sensors are zeroed, the following message is 
displayed. 

4. Click [OK] to return to the main window.

Status

Use the Status function to verify that the CubiScan is operating 
properly.

1. Select Status from the Tools menu, and the following prompt is 
displayed.

2. Verify that the CubiScan platform is free of ALL objects, then 
click [OK] to proceed.
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3. The current status is checked and an appropriate message 
returned. If there are no problems, the following message is dis-
played. 

4. Click [OK] to return to the main window.

If any problems are found, an error message appears. For exam-
ple:

TAXX – [error message]

(where XX is the error number)

If you get an error message, first verify that the CubiScan is 
turned on, then refer to the Troubleshooting chapter in your 
CubiScan manual for further help.
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Test Mode

Use the Test Mode function to set up the CubiScan for testing pur-
poses. When you select this function, the CubiScan measures, 
weighs, and displays the results continuously, as shown below.

The collected data continues to scroll on the screen until you exit 
test mode. The data collected is not recorded or saved. To exit from 
test mode, click [Cancel].
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Values

Use the Values function to display a table of sensor values that can 
be useful for troubleshooting problems with the CubiScan.

Click [OK] to return to the main window.

Calibrate

Use Calibrate to recalibrate the CubiScan sensors (or CubiScan 30 
lasers) and scale. Refer to your CubiScan manual for information on 
when the CubiScan should be calibrated.

Before calibrating the CubiScan, remove all packages or other mate-
rial from the platform, and blow any dust off the sensor screens. 
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Refer to your CubiScan manual for information on cleaning the sen-
sors.

To perform the calibration, you will need the following:

• Official test weight. The weight varies for each model of Cubi-
Scan; refer to your CubiScan manual. (It is recommended that 
you calibrate with the maximum weight.)

• Calibration cube—supplied with the CubiScan (remove the 
wrapping from the calibration cube before using).

Refer to the appropriate section below to proceed. 

Sensors

Take the following steps to calibrate the CubiScan’s sensors.

1. Select Calibrate from the Tools menu, then select Sensors. 
The following prompt is displayed.

2. Click [OK] to proceed, and the following dialog box appears.
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3. Click [Continue] (or press <F7>).

4. Click [Step 1] (or press <F1>).

5. Clear the CubiScan of all objects and click [Step 2] (or press 
<F2>).

6. Place the calibration cube on the CubiScan platform with the 
long dimension (12 inches) facing left, and click [Step 3] (or 
press <F3>).

7. Turn the calibration cube so that the long dimension (12 inches) 
is facing right, and click [Step 4] (or press <F4>).

8. Turn the calibration cube so that the long dimension (12 inches) 
is facing up, and click [Step 5] (or press <F5>).
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The sensor calibration is finished. 

9. Click [Exit] (or press <F6>) to return to the main window.

Laser

Take the following steps to calibrate the CubiScan 30 lasers. (A 
CubiScan 30 model must be selected in the Tools menu, Options, 
CubiScan tab.)

1. Select Calibrate from the Tools menu, then select Laser. The 
following prompt is displayed.

2. Place the calibration standard block on the CubiScan platform, 
and click [OK] to proceed.

3. Follow the instructions in the CubiScan 30 Operations and 
Technical Manual to calibrate the lasers.

Scale

This option may not be available for all CubiScan models. Refer to 
your CubiScan Operations And Technical Manual for information.

Take the following steps to calibrate a CubiScan scale.
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1. Select Calibrate from the Tools menu, then select Scale. The 
following prompt is displayed.

2. Click [OK] to proceed and the following dialog box appears.

3. Click [Continue] (or press <F7>). The cursor moves to the text 
box.

4. Enter the weight of the official calibration test weight. Refer to 
your CubiScan manual for specific recommendations.

5. Click [Step 1] (or press <F1>).
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6. Clear the CubiScan of all objects and click [Step 2] (or press 
<F2>).

7. Place the test weight on the CubiScan platform, wait for the 
platform to stop moving, and click [Step 3] (or press <F3>).

The scale calibration is finished.

8. Click [Exit] (or press <F6>) to return to the main window.

9. Remove the test weight from the CubiScan platform, make sure 
the platform is completely clear of all objects, and select Zero 
from the Tools menu to zero the CubiScan.
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Notes
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Chapter 5

Measuring Freight

This chapter describes how to measure freight. If your CubiScan has 
a scale, weight is automatically recorded at the same time as the 
measurements.

There are two methods you can use to measure freight in Qbit-DB 
depending on how you enter items in your database, as follows.

1. Measure items that are already listed in an imported database 
(refer to “Importing a Database” on page 63 for information on 
importing a database). Depending on your setup, there are two 
ways to select the item to be measured from the database.

Auto Advance:
If you will be measuring items in the same order they are listed 
in the database, you can set up the “Auto Advance through 
Items” function in Options (see “Database Options” on page 23 
for information). If Auto Advance is set up, you select the first 
item, and Qbit-DB automatically moves down the database list 
in sequential order as you measure and update each item. How-
ever, you can also manually click an item to select it.

Select Items Manually:
Read an item’s label to identify it, then click the item in the 
database table to select the item, as shown below.
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2. Enter items into the database manually or by scanning as you 
measure each item.

With the cursor at the “Item Number” field, you can do one of 
the following:

• If your system has a scanner, scan the item, and the number is 
inserted in the “Item Number” field. Then press <Enter>.

• Type the item number in the “Item Number” field, and press 
<Enter>.

NOTE ☞ An <Enter> key can be programmed into a barcode scanner; see 
your system or hardware administrator for assistance.

Measuring Existing Items

Do the following to measure items listed in an existing database.

1. If necessary, open the database that contains the items you are 
going to measure.

2. Verify that all of the CubiScan options have been set up cor-
rectly (see “CubiScan” on page 18).

3. Place the item to be measured on the CubiScan (refer to your 
CubiScan Operations Manual for details on correct freight 
placement).

4. In Qbit-DB, select the item to be measured using one of the 
methods described at the beginning of this section.

5. Click  to measure the item. The measurement process 
is shown on the screen, the measurements are inserted into the 
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dimension fields, and a simulation of the measured freight is 
shown in the CubiScan picture box.

6. (This step is only necessary if “tare” is enabled and the freight 
being measured requires a tare adjustment.) To apply tare values 
to an item, pull down the Actions menu and select Apply Tare 
Values, or press <Ctrl><T> after you measure the item. Tare 
values are subtracted from the measurements or weight. (Set up 
tare values in Options on the Tools menu. Refer to “Tare Val-
ues” on page 24 for information.)

7. Edit the data as required (see “Editing Data” on page 93).

8. When you are finished, click  to update the item 

record.
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To clear an item’s measurement data and start over (or to mea-

sure a different item), click . A record must either be 

updated or cleared before you can measure another item.

9. Remove the item from the CubiScan, and repeat the steps above 
for the next item.

Measuring New Items

Do the following to enter new items into the database as you mea-
sure them.

1. If necessary, open the database in which you want to enter the 
items you are measuring.

2. Verify that all of the CubiScan options have been set up cor-
rectly (see “CubiScan” on page 18).

3. Place the item to be measured on the CubiScan (refer to your 
CubiScan Operations Manual for details on correct freight 
placement).

4. Verify that the cursor is in the “Item Number” field.

If not, click  to save the last measurement or click 

 if it is not valid or is already saved.

5. Scan the item or type in the item number, and press <Enter>. 
(An <Enter> key can be programmed into a barcode scanner; 
see your system or hardware administrator for help.)
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6. Click  to measure the item. The measurement process 

is shown on the screen, the measurements are inserted into the 
dimension fields, and a simulation of the measured freight is 
shown in the CubiScan picture box.

7. (This step is only necessary if “tare” is enabled and the freight 
being measured requires a tare adjustment.) To apply tare values 
to an item, pull down the Actions menu and select Apply Tare 
Values, or press <Ctrl><T> after you measure the item. Tare 
values are subtracted from the measurements or weight. (Set up 
tare values in Options on the Tools menu. Refer to “Tare Val-
ues” on page 24 for information.)

8. Edit the data as required (see “Editing Data” on page 93).
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9. When you are finished, click  to update the item 

record.

To clear an item’s measurement data and start over (or to mea-

sure a different item), click . A record must either be 

updated or cleared before you can measure another item.

10. Remove the item from the CubiScan, and repeat the steps above 
for the next item.

Measuring Stacked Quantities

If you want to stack like items for measurement but want the dimen-
sions for each item included separately in the database, use the 
Stacked Quantities box.

1. If the Stacked Quantities box is not visible, pull down the View 
menu, and select Stacking.
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2. Place the stack of objects on the CubiScan platform. Make sure 
the edges are aligned.

3. Identify and measure the stacked objects, and enter the quantity 
in the Stacked Quantities box in the “Height,” “Length,” and 
“Width” fields as applicable.

The specified number of each dimension will be entered as separate 
items in the database.

Editing Data

At any time after measuring an item, you can edit any of its mea-
surements using one of the following methods. Click the item in the 
database table to select it.

Edit Fields You can edit any field that is not greyed (has a white background).

Click in a field to edit it, and type over the existing entry. Then click 

 to update the information in the database.

Swap
Measurements

You can change the orientation of an item using one of the “swap” 
functions. Pull down the Actions menu and select a function (or use 
the specified keyboard shortcut), as follows:

• Select Swap Length for Width (or press <Ctrl><L>) to switch 
the length and width measurement values for the selected item.

• Select Swap Width for Height (or press <Ctrl><W>) to switch 
the width and height measurement values for the selected item.

• Select Swap Height for Length (or press <Ctrl><H>) to switch 
the height and length measurement values for the selected item. 
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When you have finished, click  to update the information 

in the database.
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Chapter 6

Reports

The Reports menu contains one standard report option plus any cus-
tomized reports you may have. Customized reports are created by 
Quantronix by special arrangement.

The standard report option is a “Detail” report, explained below.

Detail Report

The Detail report lists all recorded data for the open database. Pull 
down the Report menu and select Detail to generate the Detail 
report. An example of the report is shown on the next page.

The Detail report contains all of the database detail (as shown in the 
database table). If you use user-defined fields, they are included on 
additional lines.

NOTE ☞ You can also generate reports on your measurement data by export-
ing it from Qbit-DB in a text file and importing it into another appli-
cation, such as a word processing or spreadsheet program. Refer to 
“Exporting a Database” on page 66 and “Importing a Database” 
on page 63 for information.
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Report Preview

When you select a report from the Report menu, it is displayed in 
the Preview window, as shown below.

Use the scroll bars as necessary to view the pages of the report. Or 
use the drag tool, as described on page 99.

Use the buttons on the toolbar to view or print the report, as follows.
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Click to print the report. A standard Windows print dialog box is 
displayed. Select a printer, the number of copies you want to print, 
the pages you want to print, and click [OK] to print the report.

Click to open a different report. A Load Report dialog box is dis-
played. Reports are saved in the ...\CubiScan\Qbit-DB\Data folder 
with an .fp3 extension by default. If you saved your reports in a dif-
ferent folder, select the folder. Select the report you want, and click 
[Open] to display it.
Quantronix CubiScan Qbit-DB 97



Report Preview Reports
Click to save the displayed report. A Save Report dialog box is dis-
played. Reports are saved in the ...\CubiScan\Qbit-DB\Data folder 
with an .fp3 extension by default. If you want to save your reports in 
a different folder, select the folder. Save report files can be opened 
in the Qbit-DB report viewer (see above).

Click to size the report to fit a whole page in the window.

Click to size the report to fit the width of the window.

Click to zoom the report to its full size (100%).

Click to display two pages of the report in the window.

Click the drop-down arrow and select a size to display the report, or 
click in the text box and enter a percentage.

Click to display the report on your full computer screen.
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Click to set up the report pages for printing. A Page Settings dialog 
box is displayed. Select the size, orientation, and margins for each 
page of the report, and click [OK].

Click to display an outline of the report on the left side of the win-
dow.

Click to select the drag tool. The cursor becomes a hand. Click in 
the report window, hold down the left mouse button, and drag the 
report in any direction in the window. Release the mouse button 
when it is in the position you want.

Click to select the zoom tool. The cursor becomes a magnifying 
glass. Click in the report window to zoom the report magnification 
by 25% each time you click.

Click to add a blank page to the end of the report.

Click to delete the displayed page of the report.

Click to go to the first page of the report.
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Click to go to the previous page of the report.

The number of the report page that is shown in the window is dis-
played in this text box. You can type a page number and press 
<Enter> to display that page.

Click to go to the next page of the report.

Click to go to the last page of the report.

Click to close the report and return to the Qbit-DB main window.
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Appendix A

Installation

This appendix provides instructions for installing Qbit-DB.

System Requirements

Qbit-DB is designed to operate with the following minimum com-
puter requirements:

Processor: PC Pentium III processor or better

Memory: 256 MB RAM

Hard Disk: 40 MB disk space available

Display: VGA 1024 x 768 or higher resolution color display (will not operate 
at a lower resolution; e.g., 800 x 600)

Operating System: Microsoft® Windows® 95, Windows 98, Windows NT®, Windows 
2000®, or Windows XP

Other: Quantronix Inc. CubiScan unit attached to computer
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Installing Qbit-DB

Do the following to install Qbit-DB on your computer.

1. Close any open Windows applications.

2. Insert the CubiScan CD-ROM in your CD-ROM drive. The 
Setup Wizard should start automatically. If it does not, click 
[Start], click Run, type d:setup (in which “d” is the letter of 
your CD-ROM drive), and click [OK].

The following prompt is displayed.

3. If you want the installation in a language other than English, 
select the language from the drop-down list. Click [OK] to pro-
ceed.
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The welcome window is displayed.

4. Click [Next] to continue, and the license agreement is dis-
played.
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5. Read the license agreement, and click the radio button next to “I 
accept the license agreement.” Click [Next] to continue, and the 
following window appears.
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6. Accept the default path for installation of Qbit-DB, or select a 
different drive and/or folder. Click [Next] to continue. The fol-
lowing window is displayed.
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7. Accept the default Start Menu group, or enter a different name. 
Select whether you want “All Users” to have access to Qbit-DB, 
or you want only yourself to have access to Qbit-DB on this 
computer. If you select “Just Me” a password is required to 
open Qbit-DB.

Click [Next] to continue, and the following window appears.
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8. If you want to review or change any of the settings, click 
[Back]. If not, click [Next] to continue.

The following window is displayed as the Qbit-DB files are 
copied to the specified destination folder.
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9. When the installation is complete, the following window 
appears.

10. If you do not want to start Qbit-DB now, click to remove the 
checkmark. Click [Finish] to exit and close the installation win-
dow. If “Run Qbit-DB now” was selected, Qbit-DB will open 
immediately.
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110 Quantronix CubiScan Qbit-DB



Appendix B

Frequently Asked
Questions

This appendix contains some common questions about Qbit-DB. If, 
after reading this manual and reviewing this appendix, you still have 
questions, please contact Quantronix, Inc.

Question: Do “updated records” that are exported contain data records from 
previous sessions?

Answer: Each record in the database is marked when it is updated and 
remains marked until exported. When exporting “updated records” 
all records that are marked are included.

Question: I am unable to communicate with the CubiScan unit. What should I 
do?

Answer Make sure the serial communications cable is properly connected 
with a NULL MODEM cable. Verify that the proper COM port is 
selected in the setup options in Qbit-DB. If there is still no commu-
nication, verify that the serial port on your computer is operational 
(refer to your computer’s documentation).
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